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1. Introduction 
 

This report summarizes the results of my summer research project which was carried out in the 

group of Coherent X-ray Scattering in the Photon Science department (FS-CXS) from July to 

September 2017.  

Topic of my summer research project at DESY was associated with characterization and post-

synthetic processing of gold nanorods (Au NRs). Those particles have received a lot of attention 

because of a number of promising properties that may allow using them in a number of 

applications, such as solar harvesting, photovoltaics, surface enhanced spectroscopies, sensing, 

and therapy. 

Even though a lot of reliable methods for the synthesis of gold nanorods have been developed up 

to now still a lot of challenges are left to produce monodisperse nanorods with desired 

size/aspect ratio and to ensure the stability of the stored colloidal sample for a long time. In order 

to provide the aforementioned stability one should work on the problem of nanorod surface 

chemistry which involves the surface modification of as-synthesized particles. In this project we 

carried out the ligand exchange of CTAB(cetyltrimethylammonium bromide)-stabilized Au NRs 

with PEG-SH (poly(ethylene glycol) thiol) which is widely used because it can provide 

biocompatibility and stability of Au NR solution at once. Sometimes synthesized samples may be 

not monodisperse enough and one would need to think about purifying procedure from 

undesirable shapes. In this work we applied the purification of Au nanorod colloids via depletion 

forces using addition of concentrated CTAB solution. For the post-synthetic characterization of Au 

NRs we used methods of UV-VIS-NIR spectroscopy, TEM (Transmission Electron Microscopy) and 

DLS (Dynamic Light Scattering). Additionally, the part of my work was to develop the algorithm for 

the analysis of TEM images which is more complicated for anisotropic particles. 
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2. Determination of concentration of Au nanorod solutions 
  

2.1 Experimental part 
 

The sample under study was IL 26, which was synthesized previously according to [1], 

method 1e, after synthesis the particles were centrifuged at  7000 rpm for 30 min and 

redissolved in 10 ml of water. 

The concentration of Au NRs was studied by means of UV-VIS-NIR spectroscopy. The 

absorption spectra were measured using the CARY 5000 spectrophotometer in cuvette with 

10mm path length. The concentration was determined by two methods. 

 

The first method involves the measurement of the absorbance of a diluted NR solution at 

400 nm, from which the reduction yield of gold can be precisely estimated regardless of the 

size and shape of nanoparticles [2]. This wavelength is chosen because below 400 nm the 

absorbance is influenced by organic substances and above the absorbance is influenced by 

the LSPR (Localized Surface Plasmon Resonance) of the gold nanorods. Thus, an absorbance 

at 400 nm of 1.2 corresponds to [Au0] = 0.5 mM.  

In the second method the concentration is determined from the Lambert-Beer law, where 

the extinction coefficient at the LSPR wavelength (837 nm in case of the sample IL26) is 

taken from literature [3]. Since the extinction coefficient depends on the size of particles it is 

crucial to find the reliable literature values corresponding to the particular sample.  

 

 2.2 Results and discussion 
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Figure 1 . UV-VIS-NIR spectrum of IL26 sample. 

The absorption spectrum of IL26 is shown in Figure 1, where optical density at 400 nm is 

0.327 and at 837 nm is 1.79. According to the first method, determination of [Au0] 

concentration in the cuvette was 0.327/2.4 = 0.136 mM and 0.0137 M in the bulk solution. 
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Even though the precise determination of extinction coefficients for Au nanorods seems to 

be a difficult task several groups have reported about that. In [3] several extinction 

coefficients for a number of samples of Au nanorods with different shapes and sizes at the 

LSPR wavelength were calculated using the Lambert-Beer law and the gold concentration 

determined by ICP-MS (Inductively coupled plasma mass spectrometry) analysis. Extinction 

coefficients for Au NRs at the wavelength of the longitudinal surface plasmon resonance can 

be considered as a function of effective radius, 𝑅𝑒𝑓𝑓 = √(
3𝑉

4𝜋
)

3
 (where Reff is the radius of a 

sphere having a volume, V, equal to that of the nanorod) [4]. Proceeding from this 

assumption we have calculated Reff for the sample IL26 from the results of TEM image 

analysis (which can be found below). 

The average length and diameter from the TEM were found to be 74 and 20 nanometers 

respectively. If we consider our particles as cylinders with two hemispheres at the ends 

(Fig.2) we can calculate the average volume of the particle from the data obtained from TEM 

(d = 2r):  

 

Figure 2. Schematical representation of an Au nanorod. 

V =  𝑉cylinder +  𝑉sphere = 𝜋 (
𝑑

2
)

2
(𝑙 − 𝑑) +  2 ∗

4

6
𝜋 (

𝑑

2
)

3

= 21143 nm3 

So that Reff is √(
3𝑉

4𝜋
)

3
 = 17.16 nm 

According to [3] the closest value of extinction coefficient on LSPR wavelength for this 

effective radius is 1.13*1010 L*mol-1cm-1. Optical density at the LSPR wavelength (837 nm) 

for our sample is 1.79 so we obtain the concentration in our sample to be 1.58*10-10 M (or 

0.158 nM) of Au nanorods in our sample and 15.96 nM in the bulk solution.  

To compare the obtained results from both methods we should  convert the concentration 

of [Au0] from the first method to the concentration of nanorods using the following 

equation: 

𝑐(𝐴𝑢𝑁𝑅) =
[𝐴𝑢0]∗𝑀(𝐴𝑢)

𝑉(𝑁𝑎𝑛𝑜𝑟𝑜𝑑)∗𝜌(𝐴𝑢)∗𝑁𝐴
= 0.11 nM (in the cuvette) 

and 11 nM in the bulk solution. Results of the particle concentration obtained by two 

different samples do not differ significantly (less than by 1.5 times), which is still rather 

acceptable for this accuracy level. To improve the results one should take into account the 

non-ideal shape of the particles and probably find the exact extinction coefficient value for 

the calculated Reff. 
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3. PEGylation of the Au nanorods 
 

The biggest part of my experimental work was study of surface coverage of IL26 particles to 

improve their stability. To enable the further use of synthesized gold nanorods, control of their 

surface chemistry is necessary. Typical surfactant used for synthesis of Au nanorods is 

cetyltrimethylammonium bromide (C19H42BrN, CTAB) which appears to be good in the synthesis 

procedure but not very reliable in the question of long storage. So the obtained solutions usually 

undergo a ligand exchange procedure. However, the ligand exchange of CTAB may be much more 

challenging than, for example, exchange of citrate, which is widely used in synthesis of spherical 

Au nanoparticles, and at the same time necessary both for medical purposes and many other 

scientific applications. CTAB forms a densely packed bilayer [5] at the Au NR surface that requires 

a sufficiently high concentration of unbound CTAB in solution to provide effective stabilization of 

the Au NRs. Thus, it can be really difficult to remove the surfactant (especially the surface bound) 

without affecting the stability of the colloidal suspension. Some successful results with use of 

some additives, e.g. ethanol [6] or chloroform [7] to extract CTAB, which result in sufficient 

stabilization of the nanoparticles are reported. 

Usually CTAB is exchanged for polymers to stabilize the gold nanoparticles and the most 

important type of them is poly(ethylene glycol)- (PEG-) thiols, which can provide biocompatibility 

and stability at once. Process of ligand exchange in this case is usually called PEGylation. However, 

even after this process considerable amounts of CTAB may remain on the nanorod surface, which 

rises doubts about the colloidal stability [8].  

 

To study the effect of conditions and repeatability of surface modification with PEG-SH we used 

different methods for the PEGylation of the IL26 sample. Thus we applied simple mixing of 

solutions (round 1) or preliminary CTAB removal with chloroform extraction (rounds 2-4), after 

which the success of the ligand exchange was tested using different methods.   

A plenty of methods to detect the occurred ligand exchange have been developed up to 

now. Typically FTIR-spectroscopy and X-ray photoelectron spectroscopy are used to 

determine the loading of PEG-SH on nanorods, as it is easy to find the S-Au vibration in 

spectra.  However some easier and cheaper techniques can also be used for the study of 

surface functionalization of AuNRs with PEG-SH, for example, by testing their colloidal 

stability in water upon addition of NaCl or KCl solutions [8,9]. It is also known that PEG-SH 

modified nanorods are also soluble in organic solvents (e.g. in comparison to CTAB-capped 

nanorods which are only soluble in water) [10]. Moreover, some other techniques can be 

applied to check the success of the PEGylation, for example, the etching procedure with KCN 

[11] or FeCl3 [12] where the PEG-coated Au NRs exhibit stability upon etching. The results of 

these experiments are explained below.  
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3.1 Experimental part 
 

3.1.1 PEGylation 

 
For the ligand exchange with PEG we used the sample IL26 Au nanorods. Methoxy-PEG-SH 

(CH3O-PEG-SH) with molecular weight of 800 Da was purchased from Rapp Polymere. PEG-

SH was dissolved in water and the concentration of the obtained solution was 100 mg/ml. 

Conditions of PEGylation are listed in the Table 1.  

 
Table 1. Conditions of PEGylation of IL 26 Au nanorods. 

Sample 
name 

V (IL26-
AuNRs 

solution), ml 

V (PEG 
solution), ml 

Round 1 

A1 1 1 

A3 0.250 0.5 

A4 1.5 1 

A5 1.5 1.5 

Round 2 

S1 0.3 0.5*3 

S2 0.3 0.5*3 

Round 3 

O1 0.2 0.2*3 

O2 0.2 0.033*3 

O3 0.2 0.02*3 

O4 0.2 0.067*3 

O5 0.2 0.133*3 

O6 0.2 0.01*3 

Round 4 

T1 0.15 0.25*3 

 

Round 1 

Samples A1, A3 were mixed without purification of the stock IL26 Au NRs solution and left 

stirred overnight. 

Samples A4, A5 were centrifuged and redispersed in water 2 times before adding PEG 

solution and were left stirred overnight. Sample A4 was solid on the walls of the tube after 

centrifugation, sample A5 was redispersed in water after centrifugation, but the particles 

formed big aggregates in water before addition of PEG. 
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Round 2 

Sample S1 was washed 3 times with chloroform before adding PEG; S2 was washed 3 times 

with chloroform after adding PEG. Addition of PEG was followed by centrifugation and it was 

repeated 2 times, after that the particles were redispersed in PEG solution (S1) or in 

chloroform (S2). 

Round 3 

All samples were washed 3 times with chloroform (3*0.5ml) before adding PEG solutions. 

Addition of PEG was followed by centrifugation and it was repeated 2 times, then particles 

were redispersed in PEG solution.  

Round 4 

The same procedure as in round 3. 

3.1.2 Interaction of Au NRs with KCl solution 

KCl was obtained from Riedel de Haen. Two concentrations of 0.1 and 1 M solution were 

used in this study.  

The degradation process or stability of Au NR solutions were monitored by the UV-VIS-NIR 

spectroscopy upon addition of KCL solutions. For this, 20 µl of stock Au NRs solution (IL26) 

were mixed with 1000 µl of KCl solution. Spectra were recorded with the UV-VIS-NIR CARY 

5000 spectrophotometer in the range of 1200-350 nm.  

3.1.3 Solvent exchange 

Chloroform was obtained from Sigma Aldrich. A little amount of sample dissolved in water 

was centrifuged for 15 minutes at 7000 rpm, water supernatant was removed and 

chloroform was added followed by vigorous shaking. 

3.1.4 Etching experiments 

Etching experiments were done according to (7). Typically, the solution of Au nanorods 

(IL26-stock, A4 and A1), was diluted to a final concentration of CTAB of approximately 2 mM. 

Then, 100 µL of 0.6 M FeCl3 was added to 1 mL of the above solution. The products at 

different reaction times were spun down, redispersed in ultrapure water and measured by 

the absorption spectrophotometer. 

 

 

3.2 Results and discussion 
 

3.2.1  Interaction of Au NRs with KCl solution 

As it was already mentioned before, the efficiency of the surface functionalization of Au NRs 

with PEG-SH can be investigated by testing their colloidal stability in aqueous solution at 
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different NaCl or KCl concentrations [9]. In [9] the decrease of the longitudinal surface 

plasmon (LSPR) peak intensity of the Au NRs capped with either CTAB or PEG-SH was 

observed upon increasing the NaCl concentration (compared to the absorption intensity of 

the LSPR before NaCl addition). In the case of CTAB-capped Au NRs, the rate of LSPR peak 

depletion, was almost six times higher than that of PEG-SH-capped Au NRs with increasing 

the concentration of NaCl in the Au NR dispersion (according to the slope of the LSPA peak 

intensity against different NaCl concentrations). This implies that the stability of PEG-SH-

modified Au NRs against aggregation is much higher than that of CTAB-capped Au NRs and, 

as a consequence, the toxicity effect related to massive precipitation could be minimized for 

PEG-SH-capped Au NRs in biomedical applications. 

The degradation of Au NR solutions was monitored by absorption spectroscopy (Fig. 3) The 

concentration of Au NRs was measured by UV-VIS-NIR spectroscopy and ratio of KCl to Au 

was adjusted to be the same in all cases. 
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Figure 3. Absorption spectra of different Au nanorod samples upon addition of KCl 

Plot 1 (Fig.3) represents the degradation process of IL26-stock solution with 1 M KCl 

solution. It can be seen, that the absorbance at 837 nm decreases rapidly whereas the 

absorbance at 900-1000 nm increases what refers to aggregate formation and destruction of 

the colloidal system; similar results were obtained with 0.1 M KCl solution (plot 2) where the 

degradation occurred much slower due to lower KCl concentration. At the same time the 

spectra 3-5 (PEGylated Au NRs) show almost no decay of the samples A4 and S1 during the 

observation period: the position of the LSPR peak does not change after ligand exchange 

with PEG, which indicates successful ligand modification procedure; only after one day the 

colloidal system becomes unstable. 

After these results several experiments were conducted with lower PEG concentrations to 

determine the minimum concentration of PEG necessary for successful ligand exchange. 

Unfortunately, nearly all samples were not stable enough: spectra 6-8 and 10-11 show slow 

decay during the observation time, which was not observed for the samples A4, S1 (plots 3-

5); only sample O4 (plot 9) demonstrates nearly the same stability. After this failure one 

more attempt was made to repeat the successful ligand exchange with the same amount of 

PEG-SH as in the sample 5. Unfortunately, the stability of the sample also decreased in 

comparison to the S1 sample, so we came to the conclusion that the solution of PEG-SH 

degraded. It is well-known that thiol water solutions are not very stable and decay rapidly 

[13] but in our case it was necessary to dissolve all the PEG at once in order to get the 

precise concentration.  

3.2.2 Solvent exchange 

Solvent exchange procedure was done to the particles that appeared to be stable in a KCl 

addition experiment, that are A4 and S1. Both samples redispersed readily in chloroform and 

formed a transparent solution. 
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3.2.3 Etching procedure 

 

Unfortunately, the etching experiments cannot be considered as successful. The procedure 

was done to samples IL26 and A4 and different results were obtained. Sample A4 decayed 

very fast: after 30 minutes of incubation the solution became green (typical color of Fe2+ 

compounds in water) and no trace of Au nanoparticles was found in the UV-VIS spectra. On 

the other hand, IL26 showed almost no decay: spectra remained unaltered. These results 

may indicate that the concentration of Au nanorod samples was extremely different in these 

two experiments, so that the reaction in the case of A4 happened too quickly and in the case 

of IL 26 was too slow to observe.  

In the Table 2 the observations of PEGylated Au NR samples upon addition of KCl and solvent 

exchange with chloroform are summarized. 

Table 2. Results of PEGylation experiments. 

A1 Aggregation occurred 

A3 Aggregation occurred 

A4 Stable in KCl solution 

A5 Aggregation occurred 

S1 Stable in KCl solution 

S2 
Stable CHCl3 solution; no redispersion in 
water 

O1 Slow decay in KCl solution 

O2 Slow decay in KCl solution 

O3 Slow decay in KCl solution 

O4 
Very slow decay in KCl solution: almost 
stable sample 

O5 Sample was lost by spilling 

O6 Slow decay in KCl solution 

T1 Slow decay in KCl solution 

(KCl solutions refers to both 1M and 0.1M concentrations). 

4. Characterization of Au NRs with TEM and DLS 

4.1 Experimental part 

4.1.1 TEM 

 

TEM measurements were performed at the University of Hamburg using Phillips CM 300 

transmission electron microscope with a 300 kV accelerating voltage. For TEM imaging, the 

drop containing nanoparticles was dried on a special grid. Image processing was made using 

ImageJ software (see below). 
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4.1.2 DLS measurements 

 

Multipolarization (MP) DLS measurements were carried out at the University of Hamburg.  A 

laser with λ = 520 nm was used as a light source. The DLS set up included a Glan-Thompson 

prism to adjust the polarization angle. A fast real-time software correlator based on a 

multitau algorithm ALV/LSE-5003 was used for ACF (autocorrelation functions) calculations. 

Prior to the MP DLS measurements, all samples were diluted. During MP DLS measurements, 

intensity ACFs were measured for the scattering angles of 75° and 90°; for each scattering 

angle, measurements were performed for several values of the polarization angle. The most 

often used set of angle values included 0°, 45°, 60°, 70°, 80° and 90°. Analysis of obtained 

results was done by Matlab using the code from [14] with corrected parameters for our case. 

 

4.2 Results, discussion and data processing 
 

4.2.1 TEM image analysis 

Obtained images were analyzed using ImageJ software [15]. ImageJ is a an open source Java-

based image processing program developed at the National Institutes of Health and it is 

widely used for the analyzing of TEM images of nano- and macroparticles. The automatic 

image analysis is not trivial, especially for nonspherical particles due to difficulties in 

applying the correct threshold in case of particle overlapping and various parameters 

describing the dimensions of non-spherical particles. Below a semi-automatic method that I 

developed for Au NRs in the frame of this summer project.  

The semi-automatic algorithm for nanorod analysis using with ImageJ 
 
1. Upload an image file of interest by pressing down File -> Open -> Choose the path.  

2.  Select a region of interest by applying the selection tool and drawing a box around 

the area of interest with particles you want to analyze. Then select Image -> Crop 

3. Set appropriate realistic metrics considering the preliminary designated scale:  

i. Choose "Straight Line" in the fast-access panel 

ii. Hold down the shift key and draw a straight line along the length of the scale bar of 

the image being as precise as possible 

iii. Change the data in "Known distance" and "Unit of length" strings to represented  

scale values in the following dialog window: Analyze -> Set Scale (Fig. 4.1) 

4. Apply the proposed threshold-recognition tool: Image -> Adjust -> Threshold. Adjust the 

threshold by sliding the bars so that only the particles you wish to analyze are selected.  You 

may need to slide the top bar all the way to the left and then adjust the lower bar to do this, 

then choose Apply. This operation is relevant because of noticeable contrast between each 

"particle"-shade and the background (Fig.4.2) 
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5. Choose "Flood Fill" tool in the fast-access panel and apply it on every edge-intersecting 

particle in order to avoid wrong data in the set of measurements(Fig. 4.3) 

6. If processed picture contains cross-intersecting particles it is necessary to separate them 

manually and there are three ways of doing it, the choice depends on the depth of intersection: 

 Using Erode-Dilute function 

i. Apply "Erode" tool to make the whole correction more visual-friendly: Process -> Binary 

-> Erode 

ii. Use "Pencil" and remove every existing intersection between particles (Keep in mind 

that ImageJ tends to interpret “corner-touched” pixels as intersection). 

iii. Apply "Dilute" tool to return at the initial state: Process -> Binary -> Dilute. 

 Using only the “Pencil” tool for removing all existing intersections and drawing a visible 

border between the particles (if it is obvious where it must be) (Fig. 4.4) 

 Using the "Flood Fill" tool for deleting the intersecting particles (if the particles in the 

aggregate are impossible to be distinguished as single particles) (Fig. 4.5) 

7. Check for reinstalled intersections.  

8. Cut and fill the scale bar with consecutive application of Freehand (or any other type of 

selection) tool, Edit -> Cut and  Edit -> Fill, respectively (Fig. 4.6, 4.7) 

9. Set measurements to the ones you need: Analyze -> Set Measurements. Strictly 

suggested to place a benchmark on "Limit to threshold" (Fig.  4.8) 

10.  Eventually, start the actual analysis:  Analyze -> Analyze Particles. Make the “Add to  

Manager” benchmark active for granting yourself an opportunity to manipulate with 

distinguishable ROIs. For more detailed representation "Show: Overlay" is recommended to make 

the numeration of particles visual and to see if there are any intersections left (Fig. 4.9) 

11.        By means of "Selection Rotator" (it might be useful to arrange tool on the quick-access 

 interface) and parcing through the ROI manager accomplish the following: 

 By mouse-clicking on ROI-selected line and appropriate slide of controller achieve the 

"vertical" particle position (Fig. 4.10, 4.11) 

 Press key "M" to make a measurement, the program would automatically update the 

current ROI’s position (Fig 4.12) 

 Continue actions 1 and 2 for every single selected line (Fig 4.13) 

12.        Export just acquired data in any convenient file extension format. The typical data analysis 

 implies the Excel’s math engine then .xls format stands as vital and common choice (Fig. 4.14). 

 

 

 

Different steps of the particle analysis procedure are summarized in Figure 4. 
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Figure 4. Illustrations to the semi-automatic ImageJ particle analyzing procedure 
 

After ImageJ’s procedure several .xls files had been extracted. Each of them contained width 

and length characteristics based on every outprocessed particle with total amount of 1237, 

respectively. Finally, every piece of data was united in one .xls file in order to make 

calculations more precise. For actual statistical data analysis appropriate Excel package was 

utilized, in particular, for each parameter descriptive statistics and histogram have been 

obtained. Aforementioned results are represented below: 
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 Particle width 
 

 

Bins Counts 

17 
18 
19 
20 
21 
22 
23 
24 
25 

Else 

95 
112 
186 
225 
197 
175 
106 
83 
28 
30 

Statistics 

Mean 
Standard 

error 
Median 

SD 
Dispersion 

20.14 
0.075 

 
20.245 

2.65 
7.02 

 

 

Indeed, it seems obvious that qualitatively almost every processed particle might be recognized 

as a “rod”-shaped one. Furthermore, the average particle is 20 nm in width and 74 nm in length 

with 2.6 nm and 7.8 nm standard deviations, respectively (with 95% confidence interval). Thus, it 

could be concluded that set of analyzed data has less than 15% “relative” deviation near the 

corresponding mean value for each parameter. This fact can be designated as an evidence of 

narrow size distribution for both dimensions and particles themselves.  

 

4.2.2 MP DLS 

 

Dynamic light scattering (DLS) technique allows for determination of the particles sizes and 

their distributions in a colloidal solution. Presence of a depolarized component in the light-

scattering signal enables to access both the translational and rotational diffusion of 

anisotropic particles, such as nanorods. As a result, depolarized dynamic light scattering can 

be used not just to obtain the hydrodynamic radius of the equivalent sphere but also to 

determine the actual length and diameter of diffusing nanorods. By considering nanoparticle 

Brownian motion in the terms of translational and rotational diffusion, the particle 

dimensions can be determined by the decay rates of the fluctuations of the scattered light. 

Decay rates are determined for the light scattered with two different polarizations, one of 

which (copolarization) aligns with the polarization of the exciting light (VV, polarization angle 

0°), and the other (cross-polarization) is perpendicular to it (VH, polarization angle 90°). The 

intensity autocorrelation functions (ACF) G(2)
VV(τ) and G(2)

VH(τ), where τ is the ACF delay time, 

are calculated from the time dependences of the scattered light intensity. These ACFs are 

related to the nanoparticles translational and rotational diffusion coefficients Dtrans and Drot. 

The particle length L and diameter d can be found from the values of the diffusion 

coefficients using the diffusion model for particles of a given shape (e.g., cylindrical). 

Moreover, measurements conducted at different polarization angles lead to more precise 

results in the determination of rod dimensions [14]. Depolarized DLS measurements have 

already been used for determination of the size parameters of Au nanorods and carbon 
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nanotubes [16,17]. Wide application of depolarized DLS to nonspherical nanoparticle 

characterization is limited at the moment because of challenges in measuring typically weak 

cross- polarized scattering signals and by the difficulties in analysis of experimental ACFs of 

the scattered light to determine the real dimensions of nanoparticles. 

For calculating the length L and diameter d from the diffusion coefficients a diffusion model 

for particles in a solution is needed. Typically, equations for the coefficients of the 

translational and rotational diffusion can be reduced to the form  

𝐷𝑡𝑟𝑎𝑛𝑠 =  
𝑘𝑇

3𝜋η𝐿
[𝑙𝑛𝑃 +  𝐶𝑡𝑟𝑎𝑛𝑠(𝑃)] 

𝐷𝑟𝑜𝑡 =  
3𝑘𝑇

𝜋η𝐿3
[𝑙𝑛𝑃 +  𝐶𝑟𝑜𝑡(𝑃)] 

where k is the Boltzmann constant, T is the absolute temperature in K, η is the dynamic 

viscosity of the solvent, P = L/d is the aspect ratio of the particle, Ctrans and Crot are the 

(aspect-ratio dependent) correction factors for the translational and rotational diffusion, 

respectively, that take into account the finite length effects at the ends of the cylinder. 

Different theories describing the diffusion of cylindrical particles in a liquid give different 

correction factors. In the simplest case Ctrans = Crot = 0, and the model reduces to the classical 

theory of Kirkwood, that was also used by [14] for analysis of the gold nanorod solutions and 

the same model was applied in the case of our study. The formulas that take into account 

cylinder end effects are different in different models (however, in almost all models Ctrans 

and Crot can be considered as functions of the inverse aspect ratio 1/P) and in addition to 

that, the rod shape is in most cases different from an ideal cylinder. Therefore, precise 

calculation of size parameters from the translational and rotational diffusion coefficients by 

means of theoretical modelling seems to be rather complicated.  

 

Despite the difficulties related with this method we decided to apply it to our samples and 

made MP DLS measurements of samples IL26 (as a starting sample), A4 and S1(samples after 

successful ligand exchange with PEG-SH). Dtrans and Drot were calculated from different sets 

of polarization angles in order to find the combination which results in the smallest ACF 

approximation error, which was calculated according to formula below [14]: 

 

𝛿 =  
∑ [𝐺𝑒𝑥𝑝𝑒𝑟(𝜏𝑖) −  𝐺𝑐𝑎𝑙𝑐(𝜏𝑖)]

2𝑁
𝑖=1

𝑙𝑖𝑚𝜏→∞𝐺𝑐𝑎𝑙𝑐(𝜏)
 

 

 Examples of the experimental ACFs with corresponding fits using the fitting procedure from 

[14] can be found in Figure 5.  
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Figure 5. Series of MP DLS measurements at different angles between incident and 

scattered polarizations at a fixed scattering angle.  

 

Different series of ACFs were analyzed to obtain the Drot and Dtrans coefficients. It was 

found that the set of polarization angles [0,45,60] in all cases led to the smallest mistake δ 

(see above) and these data for all samples under study can be found in Table 3.  

 

Table 3. Results from DLS measurements for samples IL26 (CTAB-stabilized Au NRs) and 

S1 (PEG-coated Au NRs, scattering angle 90°, polarization angles 0°,45°,60°) 

Sample 
Dtrans, μm2s-1 

 
Drot, ms-1 

 
length, nm diameter, nm aspect ratio 

I26 9.00 6.88 108.5±4.0 15.2±0.6 7.1 

S1 9.06 7.40 104.9±3.4 15.5±0.5 6.8 
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Comparison of DLS parameters for S1 and the initial sample IL26 shows almost no difference. 

This oddity might be interpreted as imperfection of the model used for calculation of the 

nanorod dimensions from the coefficients of the translational and rotational diffusion. 

Presumably, assumption of coefficients 𝐶𝑡𝑟𝑎𝑛𝑠(𝑃) , 𝐶𝑟𝑜𝑡(𝑃) being neglected is not acceptable 

and other expressions should be used. Authors of the method [14] also faced this inaccuracy, 

i.e. the comparison of obtained DLS data with TEM and UV-VIS results showed substantial 

difference between them.  

The obtained length and width from DLS  for the initial sample IL26 were further compared 

with the results obtained from TEM and UV-VIS data, which are summarized in Table 4. 

Nanorod aspect ratio P was also estimated from the values of the peak wavelength λLSPR   

using the formula from [18]: 

P = 0.0098·λLSPR - 4.12, where λLSPR is in nanometers. 

 

Table 4. Comparison of nanorod parameters for sample IL26 obtained from MP DLS, TEM 

and UV-VIS data  

length, nm diameter, nm Aspect ratio 

MP DLS TEM LDLS/LTEM MP DLS TEM dDLS/dTEM 
MP 
DLS 

TEM UV-VIS 

108.5±4.0 73.6± 7.8 1.47 15.2±0.6 20.1±2.6 0.75 7.1 3.7 4.1 

 

Whereas the aspect ratio obtained from TEM and absorption spectroscopy is quite similar, 

the DLS seems to overestimate the aspect ratio substantially. This leads to the conclusion 

that the assumption that the coefficients 𝐶𝑡𝑟𝑎𝑛𝑠(𝑃) , 𝐶𝑟𝑜𝑡(𝑃) can be neglected is not 

acceptable and one should take into account the aspect ratio dependence of these 

coefficients.  

 

5. Purification procedure of non-monodisperse  Au nanorod 

sample 
 

During my summer project another task was to study the purification procedure of non-

monodisperse sample of Au nanorods. Even though there are a lot of synthetic methods that 

are declared as “syntheses of monodisperse samples” [1] sometimes the resulting Au 

nanoparticles exhibit other shapes besides nanorods (especially for high aspect ratio 

samples). That is why it is desirable to establish the purification procedure which would 

remove all undesirable shapes and increase the monodispersity of the sample.  
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5.1 Experimental part 
The sample of IL28 Au NRs was synthesized previously according to [1], method 3i. After 

synthesis it was purified once (centrifuged at 7000 rpm for 30 min, redissolved in 10 ml 

water).  

Purification was based on a modified version of the method reported by Jana[19].  Typically, 

the synthesized solution of Au NRs is centrifuged, the dark precipitate is collected from each 

centrifuge tube and the supernatant is discarded. All the precipitates collected from the 

starting solution are dissolved in 40 mL of 0.3 M hot (40–50 °C) CTAB solution. After slow 

cooling process at room temperature (to avoid crystallization of CTAB due to 

supersaturation) a brown precipitate along with a pink supernatant can be observed. The 

precipitate is separated from the supernatant and again redissolved in a fresh portion of 40 

mL of 0.3 M hot CTAB solution and left for cooling. This precipitation and redispersion can be 

repeated many times, typically 4–5 times for the complete separation of long rods.  

10 ml of the initial sample was divided in two parts. Sample 1 (5 ml of stock solution) was 

purified with 0.1M CTAB solution, later centrifuged and purified twice with 0.3M CTAB, after 

that excess CTAB was removed by cleaning with water 3 times. Sample 2 (5 ml of stock 

solution) was purified with 0.3M CTAB solution three times, after that cleaned with water 3 

times. 

5.2 Results and discussion 
 

Analysis of the TEM images of the initial sample led us to the conclusion that sample is not 
monodisperse and a large amount of particles with other shapes could be found (Fig.6) 
 

 

Figure 6.  TEM image of as-synthesized IL28 Au NRs; non-rodlike particles can be seen here. 
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After the abovementioned purification procedure sample 1 was destroyed because of the 

aggregation. The reason was removal of too much CTAB due to the multiple precipitation of 

the particles, whereas sample 2 seemed to be a clean solution of Au nanorods.  

 

Figure 7. Supernatant 2 for sample 2(left) and supernatant 1 for sample 1 (right). Bright pink 

color indicates spherical particles in the solution. 

 

UV-VIS-NIR spectra of supernatants in different purification steps were measured. As it can 

be seen from Figure 8 for sample 1, the first supernatant (C1-1) contained nearly all non-

rodlike particles whereas the second supernatant (C1-2) contained mainly rods which 

indicates that one step of purification is essential to remove the majority of non-rodlike 

particles. However, the absorbance at higher wavelengths for the product spectrum (C1-P) 

indicates the particle aggregation. 

UV-VIS-NIR spectra for sample 2 show similar trend. First supernatant (C3-1) containing the 

main part of non-rodlike particles and the other supernatants (C3-2,3) containing rodlike 

particles due to inaccurate extraction. The spectrum of the final product (C3-P, the 

precipitate redissolved in water) indicates that some aggregation also occurred. However, 

due to the bigger amount of CTAB added in the purification process the purified solution of 

Sample 2 seems to be more stable after washing with water.  

 

 

 

 

 



22 
 

a

200 400 600 800 1000 1200

0.0

0.1

0.2

0.3

0.4

0.5

nm

O
.D

.

 C1-1

 C1-2

 C1-P

 

b

 

Figure 8. a) Absorption spectra of Sample 1, where C1-P is product and C1-1,2 are 

supernatants 1,2 respectively b) Absorption spectra of Sample 2, where C3-P is product and 

C3-1,2,3 are supernatants 1,2,3 respectively  

Analysis of TEM images of the sample 2 after the purification showed that the concentration 

of non-rodlike particles decreased significantly, but there are still some of them in the 

solution (Figure 9) 

  
Figure 9. TEM images of the Sample 2 after purification procedure. 

In conclusion, this type of purification does not allow us to remove all the spherical 

nanoparticles from the solution of Au nanorods, even though their concentration is 

significantly decreased. Furthermore, it has to be noted that one should be careful with 

washing of the samples after purification in order to remove excess CTAB with water, 

because addition of too much water may cause particle aggregation afterwards due to 

removal of too much CTAB needed for the stabilization of the particles.  

  

O
.D
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6. Conclusions 
 

During the summer project at DESY in the FS-CXS group we were investigating the 

properties of Au nanorods in colloidal solutions. The part of my work involved the surface 

modification of as-synthesized CTAB-coated Au NRs with methoxy-PEG-thiol ligands. 

Different methods of PEGylation were tested, several PEGylated samples were obtained and 

studied by means of different analytical methods. The stability of PEGylated Au nanorods 

dispersions in the high ionic strength media and tendency to dissolve both in organic and 

inorganic solvents were observed.  The successful ligand exchange was demonstrated by 

UV-VIS-NIR spectroscopy, where PEG-coated Au NRs solutions exhibit stability upon addition 

of KCl compared to CTAB-stabilized nanorods. 

The nanorods before and after ligand exchange with PEG were characterized by means of 

MP DLS method reported recently [14]. The calculation of translational and rotational 

diffusion coefficients from DLS data obtained for different polarization angles at a fixed 

scattering angle was used to determine the length and width of Au NRs. Whereas the length 

of Au NRs was comparable with that obtained from TEM, the width of Au NRs from DLS was 

substantially underestimated. Moreover, the purification procedure of non-monodisperse 

sample was carried out. Additionally, we developed a semi-automatic algorithm for the TEM 

image analysis using ImageJ freeware. It allows for determination of length and width of a 

large amount of Au NRs.   

Development of efficient DLS and TEM analysis of anisotropic particles within colloidal 

solutions is essential for their processing and is an intriguing topic of current and future 

investigations. 

 

  



24 
 

7. Literature references 
 

1. Ye, X., Zheng, C., Chen, J., Gao, Y., & Murray, C. B. (2013). Using binary surfactant 

mixtures to simultaneously improve the dimensional tunability and monodispersity in 

the seeded growth of gold nanorods. Nano letters, 13(2), 765-771. 
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